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Warranty And Software Licence Agreement 

WestDev Ltd and Number One Systems 

This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use 
of the Westdev and/or Number One Systems' products supplied with it. 
You agree to the terms of this agreement by the act of opening the sealed package which contains the storage 
media on which the software is recorded. Do not open the sealed package without first reading, understanding and 
agreeing the terms and conditions of this agreement. If you do not agree to the license conditions you may return 
the SOFTWARE for a full refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts 
supplied by Westdev Ltd ("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby 
grants the Customer a non-exclusive license to use the LICENSED SOFTWARE on a single computer 
workstation. Each computer workstation, even on a network, must have its own separately LICENSED 
SOFTWARE. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE 
is originally or subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or 
the copyright owner retains title and ownership of the LICENSED SOFTWARE recorded on the original media 
and all subsequent copies of the SOFTWARE, regardless of the form or media in or on which the original and 
other copies may exist. This License is not a sale of the original SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the 
subject of copyright. Unauthorised copying of the LICENSED SOFTWARE, including software which has been 
modified, merged, or included with other software, or of the written materials is expressly forbidden. You may be 
held legally responsible for any copyright infringement which is caused or encouraged by your failure to abide by 
the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is 
transferred with the LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this 
Agreement, and (iii) all complete or partial copies of the LICENSED SOFTWARE, including copies on data 
storage devices are also transferred (or destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, 
and you may not remove or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark 
notices. You must use all reasonable efforts to protect the LICENSED SOFTWARE, diskettes, and documentation 
from unauthorised use, reproduction, distribution or publication, or otherwise in violation of applicable law. Please 
contact our Customer Service department if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED 
SOFTWARE and all complete or partial copies thereof. It will also terminate if you fail to comply with any term 
or condition of this Agreement. You agree upon such termination to destroy the LICENSED SOFTWARE and all 
complete or partial copies thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, 
performance, accuracy or suitability for any purpose. In no circumstances will the copyright holder be liable for 
direct, indirect, incidental or consequential damages resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall 
apply equally to this software except where the terms of this agreement are specifically modified by the copyright 
holder(s). Such modification(s) will be included in a machine readable file on the supplied disks. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of 
copyright. 
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Chapter 1. Getting Started 
Installation 

Installation is via the autorun setup. If you are not familiar with this process it is 
explained briefly below: 

Insert the CD-ROM into your CD-ROM drive and wait a short time. The CD-ROM will 
run up to speed and an Easy-PC Welcome screen will appear. If autorun has been disabled 
on your computer you must execute the 'setup.exe' program using the Start menu and 
Run command from the Windows task bar. 

The installation is the same for new and existing users alike. Existing users i.e. version 
V3.0 to V14.0 can install V15.0 over an existing installation without deleting the old one 
first. 

With the installer running, once the Welcome screen is displayed, double-click on the 
Install Easy-PC For Windows - Version 15.0 option, or click then press Run. 
Following the instructions on the screen, you should use the same Destination Folder for 
the Program Files as your existing Easy-PC program files e.g. C:\Program Files\Number 
One Systems\Easy-PC 

All other instructions should be followed until you click Finish to complete the 
installation. 

Remember to back-up all your libraries, not only for the upgrade but also at all times 
during design. 

Data Files Location 

There is an extra step in the Setup installation wizard that asks you where you want to 
place data files (for example, libraries, technology files, etc). The default is always to use 
the common documents folder, “Users\Public\Documents\Easy-PC” on Vista and 
Windows 7, “Documents and Settings\All Users\Shared Documents” on XP etc. if you are 
installing for All Users, or into your own Documents folder if installing for current user 
only. 

Running Easy-PC For Windows 15.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, 
you may also wish to create an Easy-PC Shortcut icon that sits on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems 
folder. 
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Chapter 2. New Features in Easy-PC V15.0 
Introduction 

All features are categorised as being SCM specific, PCB specific or Both (relevant to both 
SCM and PCB design applications). 

Library Manager Changes 

Ability to export a ‘package’ of library data as a single file 

This option allows you to easily 'package' components into a single 'Easy-PC Library 
Transfer' file for moving to another system. As well as the Components, all the Symbols 
that are referenced by those Components will be included in the Transfer file. 

A new Export button on the Components tab of the Library Manager allows you to save 
the selected components and all the symbols they reference to a single transfer file. You 
can select single components or multiple components using the normal Shift, Ctrl or 
combinations of these keys. 

 
With a single component selected in the library, the Export button reveals the Export 
dialog: 
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The top part of the dialog shows the filename to which the library data will be written. In 
this example, the ‘C’ component which will create the c.elt package. 

Underneath this are three lists, one for each type of library item. In the Components list 
will be shown all the components that were selected in the Library Manager dialog. The 
PCB and SCM Symbol lists will show all the symbols that are referenced by the 
components. 

Selecting items in the lists 

If you click on any of the components in the left-hand list, the PCB and Schematic 
Symbols which are referenced by the components you have selected will be shown 
selected. Conversely, clicking on any of the symbols will show you all the components 
that reference that symbol. 

This feature can be used to 'explore' the relationship between the components and symbols 
you are going to save. This will not affect what is actually written to the target libraries, it 
is only done for information.   

Importing ‘packaged’ libraries 

To use the library items packaged up in a Library Transfer file, simply drag and drop 
the file onto the Components page of the Library Manager dialog, or use the Add File 
button to browse to where the file is stored, or double click on the filename from within a 
Windows Explorer browser dialog (the file extension .elt will automatically be mapped by 
the Easy-PC installer). 

When you do this, you can choose the library file into which each of the saved 'elements' 
(Component, PCB Symbols and/or Schematic Symbols) are stored. 



 Easy-PC V15.0 Supplement   9 

 
In order to select a library from the list, it must already exist. If you require a new library 
name, use the New Lib button on the Library Manager to do this. 

Component Edit - Allow the same pin on different gates to have different names 

Previously changing the terminal name on a pin would replicate this change across all the 
other gates that used the same symbol. Now the default action is not to do this, but you 
can use the Apply to Other Gates command on the context menu to replicate the name to 
the other gates as it used to. 

Edit the first Terminal Name: 

 
Right click on the new name, the one you wish to propagate to the other cells. 
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Click the Apply To Other Gates option from the menu. 

 
The Terminal Name is now applied to the corresponding cells. 
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Change a Component to Schematics Only 

This change now allows a component to be changed to Schematic-only by deleting the 
last package so that none appear in the Packages list of a component. Previously it would 
not allow you to exit the Packages dialog if you had deleted all the packages. Now it will 
ask you instead to confirm that you really do want to make it a schematic-only 
component. It will allow you to exit if you press the Yes button. 

 

Library Styles Manager (Both) 

On the Schematic Symbols and PCB Symbols page of the Library Manager dialog, 
there is now a Styles Tool button.  

 
The Style Manager operates on selected library items, all in the selected library or all in 
enabled libraries depending on whether you have Symbols selected or [All Libraries] 
selected. 
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A Technology file needs to be set up in the Schematic/PCB Symbol pages of the Library 
Manager under Tech Files for the Styles Tool to be enabled. 

When selected, you are presented with the Manage Library Styles dialog: 

 
Buttons on this dialog allow you to manage different Styles and Layer Line styles. Each 
dialog will display which styles are used and the ability to rename them or merge them 
with other styles. 

 
Where a style matches by its value, the style name will be displayed in the Equivalent 
cell next to it. So in the example above, style name 0, Line 5, Normal and Style1 all use 
the same width. This is perfectly acceptable if your wish to differentiate between different 
items using the same style value or thickness but where common items use different 
names, you may wish to consolidate them. 

Where style names exist but the name is meaningless, for example, Style1, you can select 
the style name and press the Rename button. Type in the new name, this might be Pins 
Names for example. 

To consolidate names, you select the cell of the style name you wish to keep. If we wish 
to keep Normal, and make Line 5 the Normal named style, you would select Normal 
from the list and press the Make Same button. Style1 will also change to Normal. 

On the Manage Library Styles dialog you can also select a pin style to use on all 
schematic symbols or select which line style to use in footprint layers. 
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Source Library Report (Both) 

Run from the Output menu and Reports, the new Source Library Report will, when 
run from a Schematic or PCB design, report which library each different Component, 
Symbol and Footprint comes from. When viewing the report, be aware that the library 
reported may be different to the one it was actually loaded from. 

 

Grids (tables) (Both) 

A new Grid control has been introduced for all dialogs that display information in a grid, 
this includes the Component Editor amongst others. 

Where information within the grid extends further than the one page displayed, you can 
now use the wheel button of the mouse to scroll up or down the page to see this 
information. 

Where it is applicable to take the current cell data and copy it to additional rows or 
columns, by right clicking the mouse in a cell, a Apply To Row/Column/All menu option 
will be available. 
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New Goto (Find) Categories (Both) 

There are new Goto categories introduced to Version 15: 

 
New PCB categories: 

Component (By Package) 

Component (By Symbol) 

Copper Pour Area  By net, but includes <No Net>. 

Dangling Track  By net 

Hole Size Unplated hole sizes listed separately with Unplated 
appended. 

Teardrop   By net, but includes <No Net> 

Testland   By net, but includes <No Net> 

Via   By net 

Plus new Schematic categories: 

Component (By Package) Not project wide 

Component (By Symbol) Not project wide 

Unrouted Connection By net, this obeys Show All Unfinished Connections 
switch in highlight Display dialog 

Measure Tool (Both) 

The Measure Tool is now available in all interactive design formats, not just PCB 
designs. This includes the Schematic editor and PCB Footprint creation to name two 
specific uses. 



 Easy-PC V15.0 Supplement   15 

Rename Component (Both) 

You can now use an interactive point-and-click component rename in the PCB and 
Schematic editors. 

From the Tools menu, select Rename Components… 

 
The Rename dialog allows you to choose the component name 'stem' to look for, then 
click around your design in the desired order to rename components in sequence. 

You can choose from the available component name 'stems' in the design. You can also 
choose the name stem to use when applying the renames - by default this is the same as 
the stem you are matching, but it can be different. For example you might wish to rename 
some connectors starting with CON to be named as PL instead.  

You also need to enter the start number from which the component names should begin. 

When you click OK, the dialog closes and the 'point and click' renaming can begin. All 
the components matching the chosen stem will be highlighted to help you see them easily 
on your design. 

Each time you select a component, the current name in the sequence is assigned to that 
component, and the sequence number is incremented. The next name to be applied is 
always displayed on the Status Bar. 

If the next name to be applied is already in use elsewhere in the design, the application 
will ensure that the names are swapped over so that no duplicate names exist. 

Other Actions 

During its use, you can select additional options from the context menu by clicking the 
right mouse button: 

 
Next Name In Sequence : this simply increments to the next available component name. 
Change Settings : this will re-display the dialog allowing you to change settings, for 
example to switch the name stem to start renaming a different type of component. 
Choose Another Page : if you are currently working on a Schematic design in a Project 
that has more than one Schematic page, this option allows you to switch to another page 
in the Project. A small dialog is displayed showing the names of the other pages, on 
choosing one that page will be opened and the Rename command automatically invoked 
so that you can start renaming on that page instead. 
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Press the Esc key or choose Cancel from the popup menu to finish the renaming 
operation.  

New Align Options (Both) 

Additional commands for centre alignment (horizontal) and middle alignment (vertical) 
been added to the Align tool. All the Align functions will now also align ‘unlike’ items 
where previously you could only align items of the same type. 

 

Select Ignores Fixed Items (Both) 

Within the Preferences dialog, the option, Select Ignores Fixed Items has been moved 
from the General Interaction box on the Interaction page to the Select box on the PCB 
Interaction and Schematic Interaction pages. This change has been made to collect 
together other new ‘select’ type options. 
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Select Only If Completely Framed (Both) 

Within the Preferences dialog, on PCB Interaction and Schematics Interaction pages 
there is a new selection option under the Select box for Select Only If Completely 
Framed. This is used by both the Frame Select and the new Polygon Select modes.  

Check this option to only select whole items that are completely within the frame or 
polygon. The default is unchecked to behave like it did previously, that is, to Frame Select 
even if the item isn’t completely framed. 

When using this option, if the Component Reference Name is outside the selection of the 
component, it is still selected to ensure it is included. 

Minimum Pick Tolerance (Both) 

Within the Preferences dialog, on PCB Interaction and Schematics Interaction pages 
there is a new selection option under the Select box for Minimum Pick Tolerance.  

Check this option to make picking more accurate, especially useful when picking whilst 
zoomed out and when using a large high definition monitor. The default is unchecked, to 
behave like it did previously. 

Drag Sensitivity (Both) 

Within the Preferences dialog, on Interaction page there is a new option Drag, this 
adjusts the Mouse Sensitivity. This allows you to tune the drag responsiveness of the 
mouse when used in the design window. This is the distance the mouse has to be dragged 
before the application recognises the operation as a mouse drag and acts accordingly. The 
reason for this option is to help avoid getting mouse drags when you are trying to perform 
a click whilst the mouse is slightly being moved.  

 
The Default button sets it to the in-built value that gives a balanced distinction between 
mouse clicks and drags. This is the value used for V14 and previous versions. 
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Polygon Select (Both) 

In select mode you can now use Polygon Select from the context menu. In this mode you 
define a polygon by clicking at its corners. Use backspace to delete a corner and double 
click to finish. Any item crossing the polygon will be selected. 

 
You can also use this mode as a single line for selection by dragging the cursor. This is 
useful for selecting angled tracks for example. The single line option ignores the Select If 
Completely Framed setting. 

To do this, enter the Polygon Select mode, drag a line (not a polygon) across items you 
wish to select: 

 
The items under the line are then selected once the cursor is released. 

 
Like Frame Select, Shift key down means select whole items, and if the Control key is 
down nothing is deselected before selecting the items with the shape. 

Tracks now selected 
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Export/Import Technology CSV (Both) 

All tabs of the Design Technology dialog (except for Wires and Rules) now have buttons 
to Export To/Import From CSV format files. The exported files can be easily edited in 
Excel for example, then imported back in with the new values. 

During Import, checks are made to ensure the right number of fields are imported and 
values are legal. 

 
Once exported into Excel, the file looks like this: 

 
All values are written in design units. If you change the Units in the CSV file for one of 
the values, to 1mm say, the imported value will be converted to the current design units. 

The CSV file can also be edited in a text editor but care must be taken to retain the correct 
file formatting. 

Copy/Paste Nets across Project (SCM) 

Pasting a net into a Project Schematic sheet now displays the Paste Net dialog if the net 
already exists in the project regardless of whether or not it is actually defined in the target 
sheet. Also, if merge is chosen, the net will inherit the attributes of the existing project net 
even if it has been copied from outside the project.  

Common SCM Nets across Project (SCM) 

When adding a new Net or Net Class to a schematic design that is part of a Project, if a 
Net Name or Class that already exists on another sheet is chosen its Properties will be 
automatically copied with the name to the current sheet. 
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Nets Technology ‘Add Project Nets’ (SCM) 

The Nets tab in the Design Technology dialog now has a Add Project Nets button if a 
schematic design belongs to a project.  

 
When selected, it will bring user-defined nets from all other Schematic designs in the 
Project that are not already defined in the current design to the list of nets shown in the 
grid. The settings for these nets may be modified in the dialog and will not be added to the 
design until OK or Apply is pressed, at which point the nets in the other project designs 
will also be synchronised to the values defined in the grid. 

Apply SCM Colours across Project (SCM) 

The Display dialog for a schematic design that is part of a Project now includes an 
additional option Apply to All Sheets.  

 
When checked, the colours displayed for the active schematic design will be applied to all 
other schematic designs in the project when OK or Apply are clicked. This includes nets 
colours for nets present in the active design. 

When a Colour File is loaded, any net colours it contains will be applied to all schematic 
designs in the project according to the current net propagation method. Other colours can 
be applied to the other schematic designs  by using the Apply to All Sheets option. 
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Schematic Net changes in Projects (SCM) 

When using a Project, any changes to Nets and Net Classes can be propagated to the 
other sheets in the Project. This includes changes to net name, net class, own colour and 
net class name and type. Auto-named nets are not affected.  

A new option on General tab in the Preferences dialog allows the method of propagating 
net changes to be defined using three options; Prompt First, Automatically, or Never. If 
the Prompt First approach is chosen, the ability to choose Yes To All is included on the 
prompt dialog when multiple nets are affected. 

 
Any affected schematic sheet not already displayed is opened automatically. An undo 
item is created on each of the affected sheets for each change. The net changes are not 
committed for each of the schematic designs until they are saved (or  a Save All is done).  

This also means that net information in Technology Files can now be applied to a project 
as a whole as even if a Net or Net Class is not present in the active design the relevant 
information will be copied to other schematic designs in the project that do use that net or 
net class. 

Panel Editor (PCB) 

The Panel Editor has been added to Easy-PC Version 15.  

A panel design is a special PCB design that contains a set of panel PCB items 
representing instances of finished PCB designs. You would use this for collecting PCB 
designs together on a panel and outputting them to manufacturing outputs such as Gerber, 
Exellon etc. 

You create a new empty panel design, or use the Panel Wizard to create a panel design 
with a set panel size and optionally include multiple instances of a PCB design.  
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Creating a New Panel 

A new panel design can be started from the File menu, New and Panel Design or Panel 
Wizard from the Wizard tab. This is not part of the PCB design editor, it is a new design 
type. 

A Technology file can be used, this acts the same as a PCB design Technology file.  

Once the panel design has been created, you can add a Panel outline from the Add menu, 
similar to using Add Board. You can also add a Panel Outline using the Panel Wizard, 
or by importing a DXF file. 

PCBs can be added to the panel using the Add PCB option from the Add menu. Single or 
multiple PCBs can also be added using the Panel Wizard. It should be stressed that only 
Easy-PC PCBs can be added to the Easy-PC Panel Editor. 

Panel Wizard 

The Panel Wizard allows you to create a new panel with a panel outline and a single or 
multiple PCB designs added in an array. Run this from the File menu and New Wizard 
page and Panel Design. 

The Technology page allows you to define your Technology file up-front and to specify 
the Design Units. This is a PCB design Technology file. 

 
The preview window displays the panel as it will appear in the design once the Finish 
button has been pressed. 

Use the <Back and Next> buttons to navigate the Wizard. Alternatively, click on the 
words in the left hand panel on the page required. 
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The PCB Design page enables you to add a design to the panel. This is not mandatory if 
you only wish to create a panel outline at this stage. If you don’t wish to add a PCB, 
uncheck the Insert PCB Design check box. 

Where inserted PCB designs contain different layer names of non-electrical layers to that 
of the Technology file, you can use the Map Non-Electrical Layers: option to map them 
to the correct layer name. In order to add PCB designs to the panel, their number of 
electrical layers and layer spans must match the layer counts in the panel. 

You can choose to reference the PCB design at its absolute file path, or have it remember 
the Relative Path to the file from the panel design. This allows you to save the panel 
design with the PCB design, and if they are both moved to different folders, the PCB 
design will still be found. 

 
The Panel Size page allows you to define how big the panel will be. You can choose from 
a user defined Panel Size, a Pre-defined Panel Size or to use an existing Panel from the 
Chosen Technology File or another Panel Design. 

 
Use the Panel Layout page to lay out and position the PCB design within the panel. You 
can also use this page to define and array of PCBs to create a step and repeat panel. 
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If you try to leave the page and the PCB designs don’t fit the panel or they overlap, you 
will be warned. 

The Finish page is used to name the Panel and Save it to file for reuse. 

 
Interactively Positioning the PCBs 

PCB design instances can be added, aligned, moved, rotated, deleted and reloaded in the 
panel design. Each instance shows its board outline and shapes from each of their 
components to aid identification of the board.  

A new Zoom option on the View menu is available to zoom to Panel Outline. 

Checking the Panel 

Check board separation, also allow boards to butt up against each other for ‘V’ cutter 
cutting. 

Design Rules Checking - Design Rule Check will check that PCB designs are not 
overlapping. 

Plotting the Panel 

The panel can be output to ODB++, Gerber, Excellon, Windows, PDF, Pen etc. as you 
would any normal PCB design. You can also output reports such as assembly machine 
reports. 

When plotting panel designs you can choose to include the full contents of the PCB 
designs, or just plot the simple displayed instance. These options are available on the 
Settings page within the Plotting & Printing dialog. 
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Adding Extra Detail 

Extra detail can be added to a panel ready for manufacture: Copper, Dimensions, Callouts, 
Text, Free Pads, Bitmaps (although they cannot be plotted in Gerber), Drill Tables and 
Layer Stack preview. Inserted drill tables in the panel will show drill count totals for all 
PCB designs in the panel. 

Components, such as Fiducial markers, can be added. These are used for assembly 
machine optical alignment or for mounting the panel onto the machine. 

Non-electrical shapes can also be added, for example routing profile indicators which 
can then be output to Excellon or Gerber. 

Routing Profile Shapes 

There are two new features to aid the creation of routing profile shapes: 

Add Shape Around PCB – Select one or more PCB instances and use this option from 
the context menu to add an outline using the Default Shape Style and Layer that fits 
tightly around each board. It is recommended that you create a new Layer and Layer 
Type to handle profiling (routing), for example, a layer named Profile Layer. The Shape 
size used should be your normal profiling tool size, consult your manufacturer for this 
information. 
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Cut Shape Tabs – From the Edit menu, this mode allows you to draw lines across shapes 
and have ‘tabs’ remove from them.  

 
You can define the width of the tabs using the Change Tab Width option from the 
context menu once in this mode. 

 
Type the value required for your tabs. 
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Trunk Routing (PCB) 

Version 15 introduces a new PCB interactive function to add multiple parallel tracks at 
the same time, the Trunk Router. This has three phases, first select the items you want to 
start from, then position the line of junctions at the start of the Trunk Route, and lastly add 
the segments of the Trunk Route.  

 
You can preselect the start items before entering Add Trunk Route on the Add menu, or 
you can enter the first phase of the mode and add or remove start items using left click, or 
select multiple items in one go by dragging using Frame Select. Clicking in space with no 
start items selected will prompt you for how many parallel tracks you want to add. 

 
Click to add corners as you would when manually routing a normal track. 

The new tracks will be separated by the appropriate track to track spacing for their nets, 
unless the selected start items are junctions at the end of parallel tracks, in which case the 
track separation will be kept. 

The ends of the dynamic tracks being added can also be welded to the ends of the same 
number of parallel tracks already in the design. 
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During Trunk Routing, a model cursor is displayed indication you are working in this 
mode. Also displayed is the centre line of path of the trunk routing. This line will always 
be on grid, and the tracks within the Trunk spaced out from this according to their Track 
to Track Spacing rules or the rule defined. 

 
Whilst adding the track segments you can change the gap between tracks using various 
functions from the context menu; Track Spacing between the tracks; Define Gap 
Between Tracks, Use Minimum Gap Between Tracks, Pull Tracks Closer Together 
and Push Tracks Further Apart. 

 
Post-Trunk Routing 

After creating the trunk route you cannot edit it as a single item, but the Cut Track 
function (see below) has been added to make it easy to remove and add new parallel 
segments in it. 
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Cut Track (PCB) 

There is a new interactive option to cut multiple PCB tracks in two places and remove the 
track segments between the two cuts. From the Edit menu, select Cut Tracks. 

Define the start and end points of the first cut and all tracks crossing it will be highlighted. 
A model cursor indicates you are in the Cut Track mode. 

 
Then position a second cut over the highlighted tracks you want to cut a section from. 

 
This second cut can be rotated (from context menu or by using a shortcut key), or be 
redefined by dragging the cursor. The tracks will be split in two by having the section 
between the two cuts removed. 

 

Profiling Shapes to Excellon Output (PCB) 

When using the Plotting & Printing dialog, you can now select a non-electrical layer(s) 
when outputting an Excellon drill file, this is in addition to [Through Hole] for normal 
drilling. This means any shapes on the selected layer, will be output as a ‘routing’ profile. 
This can be used for board profiling or for outputting slotted pads or shapes. 
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Net to Net Spacing Rules (PCB) 

You can now define spacing rules which match by Net or Net Class name and Layer 
Name. These are used to produce different spacing rules between items on matching nets. 

 
Press the Add button to add a rule. You need to define three wildcard strings which will 
match two sets of nets (or net classes) and layers. (Note: if they are not wildcard strings 
(containing '*' or '?'), then they will explicitly match a single net or layer). You can match 
a set of net class names (instead of net names) by enclosing the Match Net string in 
[square brackets].  

The Bi-Directional column indicates that the rule applies to the design types of either net 
(so the Pads to Tracks spacing will always be the same as the Tracks to Pads spacing). 
This does not have to be the case. For example [Power] nets might need a large Pads 
spacing against Tracks on all other nets (*), but a smaller value is needed for the 
reciprocal Tracks on [Power] to Pads on the other nets.  

Once a rule has been defined, it is added to the Net Match grid. You can move a rule Up 
or Down the list. The rules are applied strictly in the order that they are defined in the 
grid, until the first one which matches. So if you define the first rule as * to * on layer *, 
which matches everything, then none of the subsequent rules would ever be applied.  

If you select a row in the Net Match grid, then the spacing grid above will show the 
values which apply. Initially, all values are inherited from the design level (indicated by 
grey text). Typing values into the grid will set an override value for this rule (indicated by 
blue text). You can also delete an override value to turn it back to the inherited value.  

If you have defined the rule as Bi-Directional, then the top right half of the grid is greyed, 
because those values are the same as in the lower half of the grid. In the case when Bi-
Directional is disabled and the Match Net criteria would match either way round, then the 
larger value is used. Note that the net string * also matches with items not on a net. If you 
use this string, then the Text and Board values become available. So, for example, you 
can define a specific value between net Gnd and the Board.  
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Hollow Tracks (PCB) 

With True Width Off in the Display dialog, you can now draw PCB tracks as outlined 
hollow segments instead of just centre-line. To enable this feature, check the Hollow 
Tracks when True Width off box in Preferences and Display. 

 
Tracks appear as ‘hollow’ when enabled: 

 
In comparison, without this option selected, tracks appear as centre-line: 
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Show Legal Completion Path (PCB) 

There is a new option in Add PCB Track and Add Pull Tight Track to display the legal 
completion path from the dynamic track end to the target item at the end of the unrouted 
connection. 

 
This uses hollow segments in the unfinished track highlight colour. If it is displayed, the 
Auto Complete function will use it. Is also a switch in the PCB Tracks page of the 
Preferences dialog. 

 

Note: In Add PCB Track the Auto Complete option at top of context menu replaces the 
Auto Route option that used to appear half way down the context menu. This change is so 
that it is more obvious as to what it does, i.e. not to indicate that it is using the autorouter, 
and is now consistent with Pull Tight and Sketch Route options. 
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Arrange Components (PCB) 

On the Tools menu, a new check box, Stack Above Chosen Board/Area has been added 
to the Arrange Components dialog. The dialog has also been changed so that the Above 
First Board option has been changed to be Arrange Around First Board. 

 
Arrange Around First Board will enable components from the dialog choice to be placed 
around the board outline ready for placement. This placement makes final component 
selection and manual moving easier. 

 
Choosing Stack Above Chosen Board/Area will place the components above the first 
board outline in a stacked placement as it did previously did. 
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Optimise to Power Planes (PCB) 

Optimise will now put a zero length connection to a power plane. All zero length 
connections are now drawn in a butterfly shape. 

 

Define Number of Thermal Pad Spokes (PCB) 

Thermal spokes on pads and vias can now have any number of spokes. Change the 
Number of Spokes: from the Design Technology and Rules dialog. Normally, you 
would set this to 4 or 5 for an optimal number. This will be the maximum number of 
spokes inserted if the spokes can all be added. 

 
If the number of spokes was defined as 5, the pad would look like this: 

 

Delete Track does Unroute Preference (PCB) 

There is a new check box on PCB Interaction page of Preferences dialog, Delete Track 
Does Unroute. With this option checked, when you delete an item in a PCB, any selected 
tracks or track segments are unrouted first (just as if you had used Unroute Track 
Segments on them) before the remaining selection is deleted. 
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Remove Attached Tracks Options 

There are new check boxes on PCB Interaction page of Preferences dialog, to Remove 
Attached Tracks On:  This option is for use when deleting items other than 
components. With this left unchecked, tracks are deleted along with the deleted item. 

 

Lowlight Inactive Layers (PCB) 

During editing or move, you can control layers other than the one currently being edited 
to be dimmed in a lowlight colour. This is controlled by new switch on the Display page 
of the Preferences dialog. 

 
There is a secondary switch All In Same Colour that will draw the inactive layers in all 
the same ‘near-background’ colour instead of dimming the actual layer or item colour. 

3D Viewer Changes (PCB) 

New 3D Package Shapes 

New 3D package shapes have been added for BEAD, MELF, DILSwitch and 
LEDdisplay. 

BEAD   DILSwitch   

MELF   
LEDdisplay   

 

  



36   Easy-PC V15.0 Supplement  

Rounded Ends 

For Axial components you can choose to round off the ends of the components using the 
Rounded Ends check box. 

 

Colour-coded Bands on Components  

Can and Axial components can now be given dynamically colour-code stripes (bands) on 
the component body. The colour-code bands are based on the value of the component. 

 
CAN shapes will get a stripe up the side of the body near to pin 1 or pin 2 depending on 
the pin 1 checkbox. Axial components get a single stripe near one end or the other 
(Capacitors, Diodes etc.), except for Resistors (R) and Inductors (L) which will get the 
correct set of coloured stripes depending on the value of each component. The Value 
attribute is read and converted to a standard colour coding. Values in formats such as 
2.2K or 2K2 are accepted and converted. 
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3D View - Save As Image 

From the File menu and Save As Image, you can now write current 3D view out as an 
image file. Save As Image supports Bitmap Files (*.bmp), JPEG Files (*.jpg) and TIFF 
Files (*.tif). The background of the image will be white if the setting for Print with white 
background is enabled in the 3D Settings dialog. 

 

Option to choose Layer Type for Component Body 

There is a new selection the Settings page of 3D Settings dialog to choose the 
Component Outline Layer Type. 

 
This specifies the name of a Layer Type to be used when determining the 'size' of the 
body of the component. If this Layer Type name is specified, only shapes in the footprint 
that live on a layer of that type will be considered. The default value is to have no Layer 
Type name defined, which then allows any shapes to be matched and used for generating 
the 3D component bodies. To remove a previously specified Layer Type name, simply 
delete the text from this box. 
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New Library Contents Searcher on Web Site 

Not a new product feature but you can now actively search our web site 
(www.numberone.com/libraries.asp) for the contents of the Easy-PC optional libraries. 
Choose between different search criteria or simply choose the current version of a 
particular library to check the added contents. 

 

Micro Library 4 (Updated Cost Option) 

An additional 1,300 new micro controllers have been added to the existing Micro-
controller library from Freescale, Silicon Labs plus additional Microchip parts. If you 
have purchased any previous versions of this library already, we can supply this update to 
you for a small upgrade charge when you buy Easy-PC 15. 

A list of the updated contents can be located on our web site in the new online library 
searcher www.numberone.com/libraries.asp Select Micro in the Library: drop down list, 
then type 4 into the Version: box. Select the Search button to start the search. 

 

www.numberone.com/libraries.asp
www.numberone.com/libraries.asp
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Pro Library 4 (Updated Cost Option) 

The Pro-Library has been updated to include over 7,100 additional Parts and their 
associated Symbols and Footprints. This takes the contents of the Pro-Library to just over 
58,000 Parts! Components have been added for National, StMicro, TI, Tyco and Zilog. If 
you have purchased any previous versions of this library already, we can supply this 
update to you for a small upgrade charge when you buy Easy-PC 15. 

A list of the updated contents can be located on our web site in the new online library 
searcher www.numberone.com/libraries.asp Select ProLib in the Library: drop down 
list, then type 4 into the Version: box. Select the Search button to start the search. 

 

Note: for both updated library contents, the exact quantity may change slightly from the 
numbers above at the time of release.E&OE 

 

 

www.numberone.com/libraries.asp

